## List of Reports

**First-time users**, start here: [Pages 5-7].

**Returning users**, this table is a complete listing of current reports:

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Report Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Award</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 – Active Awards</td>
<td>Active Awards, by Investigator, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>100e – Active Awards</td>
<td>Excel data file of Active Awards, by Investigator, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>102 – Awards by Start Date</td>
<td>Awards within User-specified date-range for a Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>104 – Award Years by Start Date</td>
<td>Award Years within User-specified date range for a Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>106e - Coming Soon! AYB</td>
<td>Coming Soon! Excel data file of SAP GMGrant’s Award Year Breakdown tab, by Award, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>110, 112, 114, 116, and 118 – Award Revenue Projections</td>
<td>Award Revenue, by Investigator, Department, School, or Enterprise for User-specified date range.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>Institute Proposal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>300 – Pending Proposals</td>
<td>Pending Proposals, by Investigator, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>300e – Pending Proposals</td>
<td>Excel data file of Pending Proposals, by Investigator, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>302e – Funding Analysis</td>
<td>Excel data file of Proposals and, if funded, their Award information.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>310, 312, 314, 316, and 318 – Proposal Revenue Projections</td>
<td>Pending Proposal prorated budget amounts, by Investigator, Department or School for User-specified date range.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>320, 322, and 324 Success Rate</td>
<td>Proposal success rate by Investigator, Department, School, or Enterprise for User-specified date range.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>326 and 328 – Funding Status</td>
<td>Total of Pending Proposals and Awards for the current budget period, for School or Enterprise</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>Proposal Development</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500e - Routing Analysis</td>
<td>Excel data file of Proposal Development records, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>510 – Coeus Users in Unit</td>
<td>Coeus active Users and their assigned Coeus roles, for User-specified Unit.</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>Person</td>
<td></td>
<td></td>
</tr>
<tr>
<td>700 – Investigator History</td>
<td>All Awards and Institute Proposals for User-specified Investigator.</td>
<td>Person Search</td>
</tr>
<tr>
<td>702e– Other Support Tool</td>
<td>Excel data file of proposals and awards on with User-specified Investigator may have been budgeted for Effort.</td>
<td>Person Search</td>
</tr>
<tr>
<td>710 – Coeus Roles for User</td>
<td>Coeus roles assigned to an individual user, for User-specified person.</td>
<td>Person Search</td>
</tr>
</tbody>
</table>
# Table of Contents

## List of Reports

- Award Reports (100 series) .................................................................................................. 9
  - 100: Active Awards ........................................................................................................... 9
  - 100e: Active Awards Excel Data File .............................................................................. 10
  - 102: Awards Received by Start Date Report .................................................................. 11
  - 104: Award Years Received by Start Date Report ......................................................... 12
  - Coming Soon! 106e: Award Year Breakdown Excel Data File .................................... 13
  - 110, 112, 114, 116, and 118: Award Revenue Projection Reports .............................. 14
- Award Revenue Projection Calculations .......................................................................... 15
  - How Revenue is projected from GM Grant Master Data: Award Year Breakdown ........... 15
  - 110: Investigator Award Revenue Projection Report ....................................................... 16
  - 112: Department Award Revenue Projection Report ..................................................... 17
  - 114: School Award Revenue Projection Report ............................................................. 18
  - 116: Enterprise Award Revenue Projection Report ......................................................... 19
  - 118: Investigator Award Revenue Projection Report ....................................................... 20
- Institute Proposal Reports (300 series) ............................................................................ 21
  - 300: Pending Proposals Report ....................................................................................... 21
  - 300e: Pending Proposals Excel Data File ....................................................................... 22
  - 302e: Funding Analysis Report ....................................................................................... 23
  - 310, 312, 314, 316, and 318: Proposal Revenue Projection Reports ........................... 25
- Pending Proposal Budgeted Revenue Projection Calculations ........................................ 26
  - How Revenue is projected from Pending Proposals ..................................................... 26
  - 310: Investigator Proposal Revenue Projection Report .................................................... 27
  - 312: Department Proposal Revenue Projection Report .................................................. 28
  - 314: School Proposal Revenue Projection Report ......................................................... 29
  - 316: Enterprise Proposal Revenue Projection Report ..................................................... 30
  - 318: Investigator Proposal Revenue Projection Report .................................................... 31
  - 320, 322, and 324: Success Rate Reports ..................................................................... 32
  - 320: Departmental Success Rate Report ....................................................................... 33
  - 322: School Success Rate Report ................................................................................... 34
  - 324: Enterprise Success Rate Report ............................................................................. 35
  - 326 and 328: Funding Status Reports ............................................................................ 36
  - 326: School Funding Status Report ............................................................................... 37
  - 328: Enterprise Funding Status Report .......................................................................... 38
- Proposal Development Reports (500 series) ................................................................... 39
  - 500e: Routing Analysis Excel Data File .......................................................................... 39
  - 510: Coeus Users in Unit Report ..................................................................................... 41
Person Reports (700 series) ................................................................. 42
700: Investigator History Report .......................................................... 42
702e: Other Support Tool .................................................................... 43
710: Coeus Roles for User Report ......................................................... 46

Report Locations .................................................................................. 47
Person Search ...................................................................................... 47
Unit Hierarchy Search .......................................................................... 48

Column Headings & Terms Defined ....................................................... 52
Before You Begin

First-time Users

Follow these steps

ORIS reports are generated in Coeus Premium, from specific locations – but, not from the Main Screen of Premium. The menu of reports available under the word “Report” in the Top Menu Bar changes as you navigate to different screens (Report Locations) within Coeus.

First-time report Users, or those exploring the content of new reports, should follow these steps:

1. Read pages 5-6 to understand ORIS process and content.
2. Identify a report: List of Reports, Table of Contents, or Catalog of ORIS Reports.
3. Determine report’s ‘Report Location’: see hyperlinked ‘Report Location’ to see location description.
5. Select: from Top Menu Bar, Report->[dropdown menu].
7. Select: report format & print.

What are sources of ORIS Report data?

ORIS Reports derive award data from SAP GM Grant (imported into Coeus Award Module) and Coeus Institute Proposal Module.

➢ Information in the Awards Module is derived from two external sources: SAP and ReSource.
   ▪ SAP GMGrant and GMPProgram Master Data are the source of Coeus active Award data, including internal orders. Updated every fifteen minutes, so Sponsored Projects Shared Services postings are nearly real-time in Coeus.
   ▪ JHU’s legacy ORA database, ReSource, has been imported into Coeus to augment the SAP/Award information. All awards from ReSource have a Status of Terminated. Though ORA maintenance of ReSource ended when SAP was implemented on January 1, 2007, ReSource contained thousands of awards dating back to 1996. Those award Projects are in Coeus and displayed in ORIS reports depending on User-entered parameters.

➢ Information in Proposal Development and Institute Proposal Modules is entered by Investigators and their staff under guidance of the five Offices of Research Administration (ORAs).

Important caveats:

What does ‘Active’ Award mean in Coeus?

Coeus Award has a slightly more stringent definition of awards that are ‘active’, then does SAP. In SAP awards are considered ‘active’ with the Lifecycle Status is ‘Award’ and User Status is ‘Approved Award’. As Coeus imports these (and displays them in ORIS Reports) it also examines the SAP Grant Project End Date. If the Project End Date is on or after today’s date, then the Coeus award status will be made ‘Active’. If however, the SAP Project End Date is prior to today’s date the Coeus award status is changed to ‘Terminated’.
What Proposal Types are included in Institute Proposal ORIS Reports?

ORIS Reports for Institute Proposals only include those with a Proposal Type of: New, Renewal, Supplement, Resubmission, and Task Order. These five Proposal Types reflect the proposals for which funding is being requested and has not been previously requested. This is accurate based on the definitions of the Proposal Types in Coeus.

The digits of the Institute Proposal number describe the university's fiscal year and fiscal month in which the proposal was first routed for approval. The first two digits are the fiscal year and the third and fourth digits are the fiscal month. For example, Institute Proposal 14020933 was first routed for approval in August 2013; fiscal year ‘14’ is fiscal year 2014 which runs from July 1, 2013 to June 30, 2014 and fiscal month ‘02’ is August (the second month in the fiscal year).

What to do if your ORIS ‘e’ report displays xml code, in red ink, and not Excel?

1) If your ORIS report looks like this:

```
<?xml version="1.0" encoding="UTF-8" ?>
<?xml-stylesheet?
Workbook xmlns="urn:schemas-microsoft-com:office:spreadsheet"
xmlns:o="urn:schemas-microsoft-com:office"
xmlns:x="urn:schemas-microsoft-com:office:excel"
xmlns:ss="urn:schemas-microsoft-com:office:spreadsheet"
xmlns:html="http://www.w3.org/TR/ html140"
DocumentProperties
xmlns="urn:schemas-microsoft-com:office"
Author />
Title />
Description />
Subject />
</DocumentProperties>
Styles>
Style ss:ID="HyperlinkId"
  ss:Name="Hyperlink"
    Font ss:Color="#000000" />
```

2) Select: File>Save As.
3) Save: to Desktop.
4) Name the file.
5) Do not change the File Type.
6) Close the file.
7) Place cursor on the just-saved file.
8) Select: Mouse – Right button.
9) Select: ‘Open with’.
10) Select: Excel (note: if ‘Excel’ is not an option, contact your PC Support person or see ORIS website>TipSheet: When the ORIS Report has red code).
11) Open the Excel file.
12) Save the Excel file as you normally do.
13) Running steps 1-12 may cause your default computer settings to change and therefore eliminate this problem.
14) If the problem persists:
   a. Contact your IT support to adjust your computer/browser settings.
b. Your IT support can contact coeus-help@jhu.edu they have questions.

15) So, what happened?

16) XML, "Extensible Markup Language", is a highly efficient language for transporting large amounts of data over the internet. Coeus Grants.gov submissions use XML and so does the ORIS Reports ‘e’ reports. ORIS has observed this translation problem on computers that used Windows 7 and Internet Explorer. We do not know why, but Windows 7 and FireFox or Chrome do not exhibit problems translating XML files.
Where to report data errors found in ORIS Reports?

You may encounter several different types of data-errors in ORIS Reports that were not previously apparent in BW or other reporting tools. Report errors as follows:

- Report errors found in Pending Projects (Institute Proposals) to your Office of Research Administration, including:
  - Wrong Status
  - Wrong IPN associated with an award
  - Wrong Co-Investigators
- Report errors in Awarded Project data to Sponsored Projects Shared Services, including:
  - Wrong award amounts – Direct, Indirect, Total Costs
  - Wrong award dates – Project Start/End Dates

Where to direct questions about accessing or generating ORIS Reports?

Send questions concerning accessing or executing ORIS Reports:

- coeus-help@jhu.edu - place ‘Reports’ in the Subject line.
Award Reports (100 series)

100: Active Awards

Description: This report contains Active Awards, by Investigator, for a User-specified Unit. Investigator data shown in this report pertains only to Awards created under this reporting unit.

Information provided: Award number, Sponsor Award number (SAP Award ID), Sponsor Name, Award Start/End dates, Award Direct Cost and Total.

*Note: The information in this report is updated once a day at 6:00AM.

Report Location: Unit Hierarchy

Definition of Terms: Column Headings & Terms Defined
### 100e: Active Awards Excel Data File

**Description:** This report is the Excel data file format of Report 100 Active Awards. The report contains Active Awards, by Investigator, for a User-specified Unit. Investigator data shown in this report pertains only to Awards created under this reporting unit. **Information provided:** Award number, Sponsor Award number (SAP Award ID), Sponsor name, Award Start/End dates, Award Direct Cost and Total.

*Note: The information in this report is updated once a day at 6:00AM.*

**Report Location:** [Unit Hierarchy](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)

<table>
<thead>
<tr>
<th>UNIT_NAME</th>
<th>UNIT_NUMBER</th>
<th>AWARD_NUMBER</th>
<th>PRINCIPAL_IN</th>
<th>TITLE</th>
<th>SPONSOR</th>
<th>SPONSOR_AWARD_NUMBER</th>
<th>REPORT_NUMBER</th>
<th>TOTAL</th>
<th>REPORT_DATE</th>
<th>HOST_NAME</th>
<th>REPORT_TITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>CELL BIOLOGY-</td>
<td>17015110</td>
<td>105422</td>
<td>Robinson, Douglas</td>
<td>The Biochemical Basis for the Mechanism of Cylkinesis</td>
<td>NATL INST OF GENERAL MEDICAL SCIENC</td>
<td>R01GM066817</td>
<td>T7015110</td>
<td>1328056</td>
<td>06/01/2009</td>
<td>04/30/2013</td>
<td>Active Awards</td>
</tr>
<tr>
<td>PROGRAMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CELI BIOLOGY-</td>
<td>17015110</td>
<td>103516</td>
<td>Michaels, Susan D</td>
<td>Cytokinin Antibodies: Processing and Progeny</td>
<td>NATL INST OF GENERAL MEDICAL SCIENC</td>
<td>R01GM041223</td>
<td>T7015110</td>
<td>1398506</td>
<td>07/01/2008</td>
<td>04/30/2013</td>
<td>Active Awards</td>
</tr>
<tr>
<td>PROGRAMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CELL BIOLOGY-</td>
<td>17015110</td>
<td>112988</td>
<td>Wilson, Katherine L</td>
<td>Nek8 Functions of LEM-domain Proteins</td>
<td>US-ISRAEL SIRAT FDNATL</td>
<td>R01GM041223</td>
<td>T7015110</td>
<td>455000</td>
<td>10/01/2012</td>
<td>09/30/2016</td>
<td>Active Awards</td>
</tr>
<tr>
<td>PROGRAMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CELL BIOLOGY-</td>
<td>17015110</td>
<td>106509</td>
<td>Brookhart, Rita</td>
<td>The role of PGPM1 in hepatic cholestasis remodeling</td>
<td>NATL HEART LUNG AND BLOOD INST</td>
<td>F32HL106971</td>
<td>T7015110</td>
<td>1545300</td>
<td>01/01/2011</td>
<td>12/31/2013</td>
<td>Active Awards</td>
</tr>
<tr>
<td>PROGRAMS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**102: Awards Received by Start Date Report**

**Description:** This report contains all Awards, by Investigator, for a User-specified Unit, or aggregation of Units (School, Departments, Subdepartments, Centers), and User-specified range of Award Start Dates. Investigator data shown in this report pertains only to Awards created under this reporting unit. **Information provided:** Award number, Sponsor Award number (SAP Award ID), Sponsor name, Award Type, Activity Type, Award Status, Award Start/End dates, Total Direct Cost and Total Indirect Cost.

*Note: The information in this report is updated once a day at 6:00AM.*

**Report Location:** [Unit Hierarchy](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)
**104: Award Years Received by Start Date Report**

**Description:** This report displays Awards begun during the User-specified date range, by Investigator, by User-specified Unit and aggregation of Units (School, Departments, Subdepartments, Centers). Amounts shown are from the Award Year Breakdown applicable Budget Begin/End Dates. Investigator data shown in this report pertains only to Awards created under this reporting unit.

**Information provided:**

<table>
<thead>
<tr>
<th>Award #</th>
<th>Sponsor</th>
<th>Activity Type</th>
<th>Award Type</th>
<th>A.Y. [AYB row #]</th>
<th>Award Action [AYB]</th>
<th>Start/End Dates [AYB]</th>
<th>Direct Cost</th>
<th>Indirect Cost</th>
</tr>
</thead>
</table>

**Report Location:** [Unit Hierarchy]

**Definition of Terms:** [Column Headings & Terms Defined]
**Coming Soon! 106e: Award Year Breakdown Excel Data File**

**Description:** This ORIS Report is still in the works! **Information provided:** Information from SAP GMGrants’s Award Year Breakdown tab.

**Report Location:** [Unit Hierarchy](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)
**110, 112, 114, 116, and 118: Award Revenue Projection Reports**

**Description:** Prorated Award revenue, by Investigator, Department, School, or Enterprise for User-specified date range. *Information provided:* Unit Number and Name, Investigator, Award Number, Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost.

**How Award Revenue Projection Reports calculate prorated projections:** [Calculations](#)

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Report Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Award Revenue Projection</td>
<td>Departmental award revenue, by Investigator, for User-specified date range</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>110 – Investigator Award Revenue Projection</td>
<td>Award revenue prorated for User-specified date range and User-specified Department</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>112 – Department Award Revenue Projection</td>
<td>Award revenue prorated for User-specified date range and User-specified Department</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>114 – School Award Revenue Projection</td>
<td>Award revenue prorated for User-specified date range and User-specified School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>116 – Enterprise Award Revenue Projection, By School</td>
<td>Award revenue prorated for User-specified date range, by School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>118 – Enterprise Award Revenue Projection, By Investigator</td>
<td>Award revenue prorated for User-specified date range, by Investigator</td>
<td>Unit Hierarchy</td>
</tr>
</tbody>
</table>
Award Revenue Projection Calculations

How Revenue is projected from GM Grant Master Data>Award Year Breakdown.

ORIS calculates the portion of each funding increment in an award, the Prorated Amount, by comparing the Report’s start/end dates to Budget Dates on the SAP GM Grant Award Year Breakdown Tab. There are four Award Increment Types:

Type #1: award Budget begins before reporting period and ends during.
Type #2: award Budget begins before reporting period and ends after.
Type #3: award Budget begins during reporting period and ends after.
Type #4: award Budget begins during reporting period and ends during.

In this example, Report Period is July 1, 2009 - June 30, 2010:

<table>
<thead>
<tr>
<th>Awd Incr#</th>
<th>Type</th>
<th>GM Grant Award Year Breakdown/Coesu&gt;Anticipated Funding</th>
<th>Days Award is in Rpt</th>
<th>Rpt Prorated Calculation</th>
<th>Awd Incr#</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Bun, End Dte</td>
<td>Bun, End Dte</td>
<td>Calc Days</td>
<td>+1[*]</td>
</tr>
<tr>
<td>#1</td>
<td></td>
<td>02/01/09</td>
<td>01/12/10</td>
<td>345</td>
<td>1</td>
</tr>
<tr>
<td>#2</td>
<td></td>
<td>01/13/07</td>
<td>08/31/10</td>
<td>1,326</td>
<td>1</td>
</tr>
<tr>
<td>#3</td>
<td></td>
<td>12/03/09</td>
<td>01/12/12</td>
<td>772</td>
<td>1</td>
</tr>
<tr>
<td>#4</td>
<td></td>
<td>02/13/10</td>
<td>03/22/10</td>
<td>37</td>
<td>1</td>
</tr>
</tbody>
</table>

Steps followed to calculate each prorated amount are:

Type #1:

a) # days Award Increment is active, ex 2/1/09 - 1/12/10 = 345
b) add 1 day to 345 = 346 (*)
c) # days Award is funded within report’s period, ex. = 195
d) add 1 day to 195 = 196 (*)
e) 196/346 = 56.647%
f) % * AYB amount = Prorated Award amount reported = $566.47.

Type #2:

a) # days Award Increment is active, ex 1/13/07 - 8/31/10 = 1,326
b) add 1 day to 1,326 = 1,327 (*)
c) # days Award is funded within report’s period, ex. = 364
d) add 1 day to 364 = 365 (*)
e) 365/1,327 = 27.506%
f) % * AYB amount = Prorated Award amount reported = $275.06.

Type #3:

a) % * AYB amount = Prorated Award amount reported = $275.06
b) add 1 day to 772 = 773 (*)
c) # days Award is funded within report’s period, ex. = 211
d) add 1 day to 211 = 212 (*)
e) 212/773 = 27.426%
f) % * AYB amount = Prorated Award amount reported = $274.26.

Type #4:

a) n/a
b) n/a
c) # days Award is funded within report’s period, ex. = 37
d) add 1 day to 37 = 38 (*)
e) 38/38 = 100%
f) 100% * AYB amount = Total Award amount reported = $1,000.00.

(*) Excel & Oracle calculate dates by counting the 'lines' between the 'days', effectively not counting the first day in the range; therefore, 1 must be added to date calculations. As an example, Excel calculates 364 'days' in the calendar year 1/1/11 - 12/31/11, not 365.
110: Investigator Award Revenue Projection Report

Description: This report provides departmental Award revenue estimates, by Investigator, for a User-specified date range. Totals are provided for each Investigator and for the Department. Investigator data shown in this report pertains only to Awards created under this reporting unit. Information provided: Unit number and name, Investigator, Award number, Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

How Award Revenue Projection Reports calculate prorated projections: Calculations

Definition of Terms: Column Headings & Terms Defined

![Investigator Revenue Projection Report (Award Data) Image]

![Investigator Revenue Projection Report (Award Data) Image]
112: Department Award Revenue Projection Report

**Description:** This report provides **total** departmental Award revenue estimates, by subunit and by Investigator, for a User-specified date range. Investigator data shown in this report pertains only to Awards created under this reporting unit. **Information provided:** Unit number and name, Investigator, Award Count, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** [Unit Hierarchy](#)

**How Award Revenue Projection Reports calculate prorated projections:** [Calculations](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)

![Department Revenue Projection Report (Award Data)](image-url)
114: School Award Revenue Projection Report

Description: This report provides prorated School Award revenue estimates, by Department, for a User-specified date range. **Information provided:** Unit number and name, Award count, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.)

How Award Revenue Projection Reports calculate prorated projections: Calculations

Definition of Terms: Column Headings & Terms Defined
116: Enterprise Award Revenue Projection Report

Description: This report provides prorated Enterprise Award revenue estimates, by School, for a User-specified date range. Information provided: Unit number and name, Award count, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

How Award Revenue Projection Reports calculate prorated projections: Calculations

Definition of Terms: Column Headings & Terms Defined
118: Investigator Award Revenue Projection Report

Description: This report provides prorated Award revenue estimates, by Investigator across the Enterprise, for a User-specified date range. Information provided: Investigator, Award count, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

How Award Revenue Projection Reports calculate prorated projections: Calculations

Definition of Terms: Column Headings & Terms Defined
Institute Proposal Reports (300 series)

300: Pending Proposals Report

Description: This report lists Institute Proposals, by Investigator, which have been submitted to sponsor, but not yet funded. It is generated for a User-specified Unit, or aggregation of Units (School, Departments, Subdepartments, Centers). Investigator data shown in this report only pertains to Institute Proposals created under this reporting unit. Information provided: Institute Proposal number and link to ORIS Proposal Summary Form, Sponsor name, Award Type, Activity Type, Proposal Type, Proposal Start date, Direct Cost, Indirect Cost, and Total Cost.

*Note: The information in this report is updated once a day at 6:00AM.

Report Location: Unit Hierarchy

Definition of Terms: Column Headings & Terms Defined
# 300e: Pending Proposals Excel Data File

**Description:** This report is the Excel data file format of Report 300 Pending Proposals. The report lists Institute Proposals, by Investigator, which have been submitted to sponsor, but not yet funded. It is generated for a User-specified Unit, or aggregation of Units (School, Departments, Subdepartments, Centers). Investigator data shown in this report only pertains to Institute Proposals created under this reporting unit. **Information provided:** Institute Proposal number, Sponsor name, Award Type, Activity Type, Proposal Type, Proposal Start date, Direct Cost, Indirect Cost, and Total Cost.

*Note: The information in this report is updated once a day at 6:00AM.*

**Sorted by:** Institute Proposal number, descending

**Report Location:** Unit Hierarchy

**Definition of Terms:** [Column Headings & Terms Defined](#)

<table>
<thead>
<tr>
<th>UNIT_NAME</th>
<th>UNIT_NUMBER</th>
<th>PRINCIPAL_INVESTIGATOR</th>
<th>TITLE</th>
<th>SPONSOR</th>
<th>AWARD_TYPE</th>
<th>ACTIVITY_TYPE</th>
<th>PROPOSAL_TYPE</th>
<th>START_DATE</th>
<th>DIRECT_AMOUNT</th>
<th>INDIRECT_AMOUNT</th>
<th>TOTAL_AMOUNT</th>
<th>INSTITUTION_PROPOSAL_NUMBER</th>
<th>REPORT_NUMBER</th>
<th>PARENT_INSTITUTION_PROPOSAL_NUMBER</th>
<th>REPORT_DATE</th>
<th>REPORT_TITLE</th>
<th>HOST_NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Biology- Programs</td>
<td>T7015110</td>
<td>Lampert, Thomas</td>
<td>Utilizing cell line substrate adhesion to discover novel regulators of cancer</td>
<td>AM Cancer Soc</td>
<td>Grant</td>
<td>Instruction</td>
<td>New</td>
<td>07/01/2013</td>
<td>0</td>
<td>15000</td>
<td>0</td>
<td>15000</td>
<td>13025930</td>
<td>17015110</td>
<td>2013-09-25</td>
<td>Pending Proposals</td>
<td>pocoeus</td>
</tr>
<tr>
<td>Cell Biology- Programs</td>
<td>T7015110</td>
<td>Sesaki, Hiroshi</td>
<td>Mitochondrial Dynamics in Neuronal Aging</td>
<td>AM FEDERATIO FOR AGING RESEARCH</td>
<td>Grant</td>
<td>Organized Research</td>
<td>New</td>
<td>07/01/2013</td>
<td>50000</td>
<td>50000</td>
<td>50000</td>
<td>13064939</td>
<td>17015110</td>
<td>2013-02-25</td>
<td>Pending Proposals</td>
<td>pocoeus</td>
<td></td>
</tr>
<tr>
<td>Cell Biology- Programs</td>
<td>T7015110</td>
<td>Qasem, Sara J</td>
<td>Role of the oxygen-dependent hydroxylase OGDH in the transition to solid tumor</td>
<td>AM HEART ASSN</td>
<td>Grant</td>
<td>Instruction</td>
<td>New</td>
<td>07/01/2013</td>
<td>50000</td>
<td>0</td>
<td>50000</td>
<td>13074932</td>
<td>17015110</td>
<td>2013-02-25</td>
<td>Pending Proposals</td>
<td>pocoeus</td>
<td></td>
</tr>
<tr>
<td>Cell Biology- Programs</td>
<td>T7015110</td>
<td>Espenhaa, Peter</td>
<td>Translation Function of the Polyhystein O681 in Transition</td>
<td>AM HEART ASSN MARYLAND AFFILIATE</td>
<td>Grant</td>
<td>Organized Research</td>
<td>New</td>
<td>07/01/2013</td>
<td>14000</td>
<td>14000</td>
<td>15400</td>
<td>13074944</td>
<td>17015110</td>
<td>2013-02-25</td>
<td>Pending Proposals</td>
<td>pocoeus</td>
<td></td>
</tr>
</tbody>
</table>
302e: Funding Analysis Report

Description: This report contains proposal information and, if applicable, corresponding funding information for Institute Proposals in a User-specified fiscal year(s). The report offers the detailed analysis of Success Rates and Rates of Funding based on the Institute Proposals by time period, by proposal characteristics, by Unit (Department, Division) and by Sponsor characteristics. The definitions and formulas for Success Rate and Rate of Funding are in the Column Headings & Terms Defined section.

The fiscal year and month are based on the first four digits of the Institute Proposal number. See the second paragraph of What Proposal Types are included in Institute Proposal ORIS Reports? in the Before You Begin section. The Fiscal Year is literally the first two digits of the Institute Proposal number and the Fiscal Month is the third and fourth digits of the Institute Proposal number. Columns A through AI pull information from the Institute Proposal and Columns AJ through AP pull information from the corresponding Award, if applicable.

Note regarding the DHHS transition to PMS Subaccount billing: Please see the official NIH notice here. If DHHS switches the billing mechanism for an award mid-project (for example, at the start of Year 4 of a five year award), SAP requires the creation of a new SAP Grant number for the period(s) awarded through the PMS Subaccount. If this occurs and the project is processed correctly, ORIS Report 302e will report the project as follows. The original Institute Proposal number and all of its original information will be included in the report. The award information for the Institute Proposal will pull from both the original SAP Grant and new (PMS Subaccount) SAP Grant as described: Award number = new SAP Grant number, Award Status = new SAP Grant status, Award Start = original SAP Grant start date, Award End = new SAP Grant end date, Anticipated Total = the summation of the Funded Amounts from both SAP Grants minus all awarded Supplements, Award Date = original SAP Grant award date. Please contact the ORA with questions about PMS Subaccounts and contact ORIS with questions regarding PMS Subaccount reporting.

Report Location: Unit Hierarchy

Definition of Terms: Column Headings & Terms Defined

Information provided:

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Fiscal Month</th>
<th>Inst. Proposal Number</th>
<th>Proposal Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Type</td>
<td>Anticipated Award Type</td>
<td>Proposal Status</td>
<td>Business Area (*)</td>
</tr>
<tr>
<td>Unit Number</td>
<td>Unit Name</td>
<td>Department</td>
<td>Division</td>
</tr>
<tr>
<td>Aggregated Division (*)</td>
<td>Title</td>
<td>Sponsor Code</td>
<td>Sponsor</td>
</tr>
<tr>
<td>Sponsor Type</td>
<td>Aggregated Sponsor Type (*)</td>
<td>Prime Sponsor Code</td>
<td>Principal Investigator</td>
</tr>
<tr>
<td>Employee ID (of PI)</td>
<td>Request First Period Start</td>
<td>Request Total Period Start</td>
<td>Request First Period End</td>
</tr>
<tr>
<td>Request Total Period End</td>
<td>Request First Period Direct</td>
<td>Request Total Period Direct</td>
<td>Request First Period Indirect</td>
</tr>
<tr>
<td>Request Total Period Indirect</td>
<td>Request First Period Total</td>
<td>Request Total Period Total</td>
<td>Announcement Number</td>
</tr>
<tr>
<td>Subcontract Flag</td>
<td>ARRA Proposal</td>
<td>ORA</td>
<td>Submission Date</td>
</tr>
<tr>
<td>Award Number</td>
<td>Award Status</td>
<td>Award Start</td>
<td>Award End</td>
</tr>
<tr>
<td>Anticipated Total</td>
<td>Award Date</td>
<td>ARRA Award</td>
<td></td>
</tr>
<tr>
<td>Notice about Descriptors</td>
<td>Report Number(#)</td>
<td>Report Title(#)</td>
<td>Parameter Entered 1(#)</td>
</tr>
</tbody>
</table>

(*) Indicates data fields which enable the report to be used across the enterprise.

(#) Indicates crucial ORIS report information inserted into every row of the report which enable each row of data to be replicated.
Below is a partial sample report. The User-specified variables were:

<table>
<thead>
<tr>
<th>Fiscal Year Start</th>
<th>Parameter 1</th>
<th>Fiscal Year End</th>
<th>Parameter 2</th>
<th>Unit Number</th>
<th>Parameter 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>2013</td>
<td>Parameter 1</td>
<td>2013</td>
<td>Parameter 2</td>
<td>17015110</td>
<td>Parameter 3</td>
</tr>
</tbody>
</table>
310, 312, 314, 316, and 318: Proposal Revenue Projection Reports

**Description:** Pending Proposal prorated budget amounts, by Investigator, Department or School for User-specified date range. **Information provided:** Unit Number and Name, Investigator, Institute Proposal number, Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost.

How Proposal Revenue Projection Reports calculate prorated projections: Calculations

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Report Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposal Revenue Projection</td>
<td>Departmental pending proposal prorated budget amounts, by Investigator, for User-specified date range</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>310 – Investigator Proposal Revenue Projection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>312 – Department Proposal Revenue Projection</td>
<td>Pending prorated budgeted amounts for User-specified date range and User-specified Department</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>314 – School Proposal Revenue Projection</td>
<td>Pending prorated budgeted amounts for User-specified date range and User-specified School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>316 – Enterprise Proposal Revenue Projection, By School</td>
<td>Pending prorated budgeted amounts for User-specified date range, by School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>318 – Enterprise Proposal Revenue Projection, By Investigator</td>
<td>Pending prorated budgeted amounts for User-specified date range, by Investigator</td>
<td>Unit Hierarchy</td>
</tr>
</tbody>
</table>
Pending Proposal Budgeted Revenue Projection Calculations

How Revenue is projected from Pending Proposals.

ORIS calculates the portion of each prorated Pending Proposal by multiplying the average daily Total Period requested amount by the number of days contained in the User-specified date range.

Example – calculating the prorated Direct Cost to be reported for the first Institute Proposal (submitted proposal) of Fiscal Year 2014 (i.e. #14010001):

1) Project (proposal) Dates:
   i) Start Jan. 1, 2015
   ii) End Dec. 31, 2019

2) Project Budget:
   i) Yr 1-5, Direct Cost $3,000,000
   ii) Yr 1-5, Indirect Cost $2,000,000
   iii) Yr 1-5, Total Cost $5,000,000

3) User-specified Report date range:
   i) 9 months:
      (1) August 15, 2015 -
      (2) May 14, 2016.

4) ORIS REPORTS will calculate the Direct Cost by:
   a) Project (proposal) info:
      i) Project (proposal) Days:
         (a) 1,826 days (1/1/2015 – 12/31/2019)
      ii) Project (proposal) Direct Cost:
         (a) $3,000,000
      iii) Average Project (proposal) Direct Cost per day:
         (a) $1,642.94
   b) Reported data:
      i) Report data range:
         (a) 274 days (8/15/2015 – 5/14/2016)
      ii) Reported Direct Cost:
         (a) $450,164 (274 x $1,642.94)
**310: Investigator Proposal Revenue Projection Report**

**Description:** This report provides departmental prorated Pending Proposal requested amounts, by Investigator, for a User-specified date range. Totals are provided for each Investigator and the Department. Investigator data shown in this report pertains only to Institute Proposals created under this reporting unit. **Information provided:** Unit number and name, Investigator, Institute Proposal number, Title, Award Type, Activity Type, Project End Date, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** [Unit Hierarchy](#)

**How Proposal Revenue Projection Reports calculate prorated projections:** [Calculations](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)

---

### Investigator Revenue Projection Report (Proposal Data)

<table>
<thead>
<tr>
<th>Proposal Number</th>
<th>Sponsor</th>
<th>Title</th>
<th>Award Type</th>
<th>Activity Type</th>
<th>End Date</th>
<th>Direct</th>
<th>Indirect</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>17015110: CELL BIOLOGY-PROGRAMS</td>
<td>NATL CANCER INST</td>
<td>Cytoskeleton regulation of cell cycle arrest</td>
<td>Grant</td>
<td>Organization</td>
<td>6/30/13</td>
<td>$99,220</td>
<td>$44,901</td>
<td>$144,121</td>
</tr>
<tr>
<td>11034469</td>
<td>NATL INST OF HEALTH</td>
<td>Regulation of C. elegans embryo development</td>
<td>Grant</td>
<td>Organization</td>
<td>11/30/16</td>
<td>$27,707</td>
<td>$17,867</td>
<td>$45,574</td>
</tr>
<tr>
<td>11035575</td>
<td>NATL INST OF HEALTH</td>
<td>Cytoskeletal dynamics in the regulation of cell cycle arrest</td>
<td>Grant</td>
<td>Organization</td>
<td>6/30/13</td>
<td>$50,153</td>
<td>$2,812</td>
<td>$52,965</td>
</tr>
<tr>
<td>11035575</td>
<td>NATIONAL INSTITUTE OF DENTAL AND ORAL HEALTH</td>
<td>Cytoskeletal dynamics in the regulation of cell cycle arrest</td>
<td>Grant</td>
<td>Instruction</td>
<td>6/30/16</td>
<td>$39,596</td>
<td>$30,454</td>
<td>$60,050</td>
</tr>
</tbody>
</table>

**Summary:**

- **CELL BIOLOGY PROGRAMS:** $27,135
- **Total:** $44,217

---

### Investigator Revenue Projection Report (Proposal Data)

<table>
<thead>
<tr>
<th>Proposal Number</th>
<th>Sponsor</th>
<th>Title</th>
<th>Award Type</th>
<th>Activity Type</th>
<th>End Date</th>
<th>Direct</th>
<th>Indirect</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>17015110: CELL BIOLOGY-PROGRAMS</td>
<td>NATL INST OF GENERAL MEDICAL SCIENCE</td>
<td>Ultrastructure mediated cytokine and CRP quality control in yeast</td>
<td>Grant</td>
<td>Organization</td>
<td>11/30/15</td>
<td>$37,155</td>
<td>$17,082</td>
<td>$44,237</td>
</tr>
</tbody>
</table>

**Summary:**

- **CELL BIOLOGY PROGRAMS:** $37,155
- **Total:** $44,237
312: Department Proposal Revenue Projection Report

Description: This report provides departmental Pending Proposal prorated requested amounts, by subunit and by Investigator, for a User-specified date range. Investigator data shown in this report pertains only to Institute Proposals created under this reporting unit. Information provided: Unit number and name, Investigator, Institute Proposal count, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

How Proposal Revenue Projection Reports calculate prorated projections: Calculations

Definition of Terms: Column Headings & Terms Defined
314: School Proposal Revenue Projection Report

**Description:** This report provides prorated School Pending Proposal requested amounts, by department, for a User-specified date range. **Information provided:** Unit number and name, Institute Proposal count, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** [Unit Hierarchy](#)

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.)

**How Proposal Revenue Projection Reports calculate prorated projections:** [Calculations](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)
**316: Enterprise Proposal Revenue Projection Report**

**Description:** This report provides prorated Enterprise Pending Proposal requested amounts, by School, for a User-specified date range. **Information provided:** Unit number and name, Institute Proposal count, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** Unit Hierarchy

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.)

**How Proposal Revenue Projection Reports calculate prorated projections:** Calculations

**Definition of Terms:** Column Headings & Terms Defined

---

**Enterprise Revenue Projection Report (Proposal Data)**

<table>
<thead>
<tr>
<th>Projects</th>
<th>Direct</th>
<th>Indirect</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIVERSITY ADMINISTRATION: 10100000</td>
<td>$1,667</td>
<td>$0</td>
<td>$1,667</td>
</tr>
<tr>
<td>APL COST CENTER: 10400000</td>
<td>$0</td>
<td>$0</td>
<td>$0</td>
</tr>
<tr>
<td>HOMewood STUDENT AFFAIRS: 11000000</td>
<td>$165,097</td>
<td>$0</td>
<td>$165,097</td>
</tr>
<tr>
<td>Krieger SCHOOL OF ARTS &amp; SCIENCES: 11500000</td>
<td>$15,956,010</td>
<td>$6,265,544</td>
<td>$22,221,554</td>
</tr>
<tr>
<td>WHiting SCHOOL OF ENGINEERING: 12000000</td>
<td>$21,565,188</td>
<td>$9,485,729</td>
<td>$31,050,917</td>
</tr>
<tr>
<td>SCHOOL OF EDUCATION: 12500000</td>
<td>$1,133,040</td>
<td>$339,005</td>
<td>$1,472,045</td>
</tr>
<tr>
<td>シェーマニアン LIBRARY: 16000000</td>
<td>$116,714</td>
<td>$19,253</td>
<td>$135,967</td>
</tr>
<tr>
<td>NETze SCHOOL OF ADVANCED INTERNATIONAL STUDIES: 16000000</td>
<td>$302,077</td>
<td>$159,284</td>
<td>$461,361</td>
</tr>
<tr>
<td>BOLOGNA CENTER: 14100000</td>
<td>$335,333</td>
<td>$0</td>
<td>$335,333</td>
</tr>
<tr>
<td>BLOOMBERG SCHOOL OF PUBLIC HEALTH: 16000000</td>
<td>$126,324,526</td>
<td>$35,376,856</td>
<td>$161,601,382</td>
</tr>
<tr>
<td>SCHOOL OF NURSING: 16500000</td>
<td>$2,391,955</td>
<td>$635,093</td>
<td>$3,027,048</td>
</tr>
<tr>
<td>SCHOOL OF MEDICINE: 17000000</td>
<td>$2,491,655,182</td>
<td>$91,023,786</td>
<td>$2,582,678,968</td>
</tr>
<tr>
<td>AMERICAN INSTITUTE FOR CONTEMPORARY GERMAN STUDIES: 20500000</td>
<td>$78,986</td>
<td>$0</td>
<td>$78,986</td>
</tr>
<tr>
<td>BIOETHICS INSTITUTE: 21000000</td>
<td>$667,281</td>
<td>$395,568</td>
<td>$1,063,888</td>
</tr>
<tr>
<td>CENTER FOR TALENTED YOUTH: 21500000</td>
<td>$5,545</td>
<td>$5,470</td>
<td>$11,015</td>
</tr>
<tr>
<td>EVERGREEN HOUSE: 22000000</td>
<td>$16,652</td>
<td>$0</td>
<td>$16,652</td>
</tr>
<tr>
<td>JHPIEGO: 23000000</td>
<td>$100,208,439</td>
<td>$11,618,525</td>
<td>$111,826,964</td>
</tr>
<tr>
<td>INSTITUTE FOR POLICY STUDIES: 24000000</td>
<td>$310,522</td>
<td>$3,501</td>
<td>$314,023</td>
</tr>
</tbody>
</table>

**Summary of Report:**

- **Projects:** 7,751
- **Total Direct Costs:** $587,294,647
- **Total Indirect Costs:** $155,384,483
- **Total Costs:** $742,679,130
318: Investigator Proposal Revenue Projection Report

**Description:** This report provides prorated Pending Proposal requested amounts, by Investigator across the Enterprise, for a User-specified date range. **Information provided:** Investigator, Institute Proposal count, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** Unit Hierarchy

(This dropdown menu overrides any specific unit highlighted in the Unit Hierarchy.)

**How Proposal Revenue Projection Reports calculate prorated projections:** Calculations

**Definition of Terms:** Column Headings & Terms Defined

![Investigator Revenue Projection Report (Proposal Data)]
## 320, 322, and 324: Success Rate Reports

**Description:** Proposal success rate for Investigator, Department, School, or Enterprise. **Information provided:** Investigator, Department, School, number of Institute Proposals, Funded Institute Proposals, and percent funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided.

**How Success Rate Reports calculate success rates:** \( \frac{\text{Funded Institute Proposals}}{\text{Funded} + \text{Not Funded} + \text{Pending Institute Proposals}} \)

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Report Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success Rate Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>320 Department Success Rate</td>
<td>Proposal success rate summarized by Investigator for User-specified Department</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>322 – School Success Rate</td>
<td>Proposal success rate summarized by Department for User-specified School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>324 – Enterprise Success Rate</td>
<td>Proposal success rate summarized by School when user selects JHU Enterprise</td>
<td>Unit Hierarchy</td>
</tr>
</tbody>
</table>
320: Departmental Success Rate Report

Description: This report is for a User-specified Unit, by Investigator. It shows each Investigator’s level of success of proposal funding during a User-specified date range. Investigator data shown in this report pertains only to Institute Proposals created under this reporting unit. Information provided: Investigator, number of Institute Proposals, Funded Institute Proposals, and percent funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided.

Report Location: Unit Hierarchy

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded + Not Funded + Pending Institute Proposals)

Definition of Terms: Column Headings & Terms Defined

<table>
<thead>
<tr>
<th>Unit Name: CELL BIOLOGY-PROGRAMS</th>
<th>Projects Awarded</th>
<th>Projects Not Awarded</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Proposals</td>
<td>Projects</td>
</tr>
<tr>
<td>170150000 CELL BIOLOGY-PROGRAMS</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>Zhou, Qianqing</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Cheng, Se Yean</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>Mithowal, Susan D</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Horn, Troy</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>Machamer, Carolyn E</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Hubbard, Ann L</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Lloyd, S J</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Kao, Scott C</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Simon, Dan</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Iglarzor, Pablo A</td>
<td>12</td>
<td>4</td>
</tr>
<tr>
<td>Andrew, Deborah J</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Cai, Haaxing</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>Swanson, Kristen</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Horigome, Chihoro</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Tomura, Yasushi</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>Manoshi, Eda</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>Gray, Ryan S</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Jensen, Robert E</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Robinson, Douglas</td>
<td>12</td>
<td>2</td>
</tr>
</tbody>
</table>

17015110 CELL BIOLOGY-PROGRAMS Unit Total: 155 39 25.2% 24 88 0 4

Report Total: 155 39 25.2% 24 88 0 4

Office of Research Information Systems
Report 6611 Departmental Success Rate

02/02/2012 04:11 PM
2 of 2
322: School Success Rate Report

Description: This report is for a User-specified date-range and School. It shows each Department’s level of success of proposal funding. **Information provided:** Department name, number of Institute Proposals, Funded Institute Proposals, and percent funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided.

Report Location: **Unit Hierarchy**

**How Success Rate Reports calculate success rates:** \((\text{Funded Institute Proposals}) / (\text{Funded + Not Funded + Pending Institute Proposals})\)

Definition of Terms: [Column Headings & Terms Defined]

![School Success Rate Report](image)
324: Enterprise Success Rate Report

Description: This report is for a User-specified Enterprise (University or Health System), by School. It shows each School's level of success of proposal funding during a User-specified date range. Information provided: School Unit number and name, number of Institute Proposals, Funded Proposals, and percent funded; also, number of Pending Proposals, and Proposals Not Funded, Withdrawn, or otherwise Voided.

Report Location: Unit Hierarchy

How Success Rate Reports calculate success rates: (Funded Institute Proposals) / (Funded Institute Proposals + Not Funded Institute Proposals + Pending Institute Proposals)

Definition of Terms: Column Headings & Terms Defined
326 and 328: Funding Status Reports

Description: Total of Pending Proposals and Awards for the current budget period, for School or Enterprise. Information provided: Department or School Unit number and name, Pending Proposals: number, Direct Cost, Indirect Cost, Total Cost; Awards: number, Direct Cost, Indirect Cost, and Total Cost.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Description</th>
<th>Report Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Funding Status Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>326 - School Funding Status</td>
<td>Total Pending Proposals and Awards for the current budget period, by School</td>
<td>Unit Hierarchy</td>
</tr>
<tr>
<td>328 – Enterprise Funding Status</td>
<td>Total Pending Proposals and Awards for the current budget period, by Enterprise</td>
<td>Unit Hierarchy</td>
</tr>
</tbody>
</table>
326: School Funding Status Report

**Description:** Provides a count of Pending Proposals and Awards for School, by Department. Displays Pending Proposals requested amounts for the First Budget Period and Active Awards incremental award amounts applicable to the JHU Fiscal Year in which the report is generated. Pending Proposals and Awards beginning after the end of the current Fiscal Year are not included. **Information provided:** Department Unit number and name, Pending Proposals: number, Direct Cost, Indirect Cost, Total Cost; Awards: number, Direct Cost, Indirect Cost, and Total Cost.

**Report Location:** Unit Hierarchy

**Definition of Terms:** Column Headings & Terms Defined
328: Enterprise Funding Status Report

Description: Provides a count of Pending Proposals and Awards for Enterprise, by School. Displays Pending Proposals requested amounts for the First Budget Period and Active Awards incremental award amounts applicable to the JHU Fiscal Year in which the report is generated. Pending Proposals and Awards beginning after the end of the current Fiscal Year are not included. Information provided: School Unit number and name, Pending Proposals: number, Direct Cost, Indirect Cost, Total Cost; Awards: Number, Direct Cost, Indirect Cost, and Total Cost.

Report Location: Unit Hierarchy

Definition of Terms: Column Headings & Terms Defined
Proposal Development Reports (500 series)

500e: Routing Analysis Excel Data File

Description: This report contains Proposal Development records with a status other than Recalled or Rejected for a User-specified Unit and date range. The date range is determined by the date that the Proposal Development record was first routed for approval. The report includes details about the Proposal Development record as well as routing information: the user who started approval, when approval was started, the user who finished approval, when approval was completed, and several other pieces of information. In addition, if the proposal was submitted to Grants.Gov, the report includes the Grants.Gov Application Type and Status.

*Note: The information in this report is updated once a day at 6:00AM. See the footnote at the bottom of the Excel Data File.

Report Location: Unit Hierarchy

Definition of Terms: Column Headings & Terms Defined

Information provided:

<table>
<thead>
<tr>
<th>Proposal Development</th>
<th>Proposal Type</th>
<th>Activity Type</th>
<th>Anticipated Award Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Title</td>
<td>Business Area</td>
<td>Unit Number</td>
</tr>
<tr>
<td>Unit Name</td>
<td>Department</td>
<td>Division</td>
<td>Aggregated Division</td>
</tr>
<tr>
<td>Principal Investigator</td>
<td>Sponsor Code</td>
<td>Sponsor</td>
<td>Sponsor Type</td>
</tr>
<tr>
<td>Aggregated Sponsor Type</td>
<td>Prime Sponsor Code</td>
<td>CFDA Number</td>
<td>Announcement Number</td>
</tr>
<tr>
<td>System-to-System Type</td>
<td>System-to-System Submission Status</td>
<td>Deadline</td>
<td>Routing Start User</td>
</tr>
<tr>
<td>Routing Start Date</td>
<td>Weekdays Routed Before Deadline</td>
<td>Routing Next Approver</td>
<td>ORA Receipt Date First Attempt</td>
</tr>
<tr>
<td>Weekdays ORA Received before Deadline</td>
<td>ORA Receipt Date Final Attempt</td>
<td>Routing End User</td>
<td>Routing End Date</td>
</tr>
<tr>
<td>Routing Attempts</td>
<td>ORA</td>
<td>Fiscal Year</td>
<td>Fiscal Month</td>
</tr>
</tbody>
</table>

Notice about Descriptors
Caution: if the following fields are removed from the spreadsheet ORIS will be unable to validate the data.

<table>
<thead>
<tr>
<th>Parameter Entered 1</th>
<th>Parameter Entered 2</th>
<th>Run Time</th>
<th>Host Name</th>
</tr>
</thead>
</table>

The following page includes a partial sample report.
<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
<th>Q</th>
<th>R</th>
<th>S</th>
<th>T</th>
<th>U</th>
<th>V</th>
<th>W</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>00040674</td>
<td>New</td>
<td>Organized Res</td>
<td>Grant</td>
<td>Submitted</td>
<td>Health Effects of Extreme</td>
<td>170</td>
<td>17004027</td>
<td>PULMONARY</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>McCombs</td>
<td>010060</td>
<td>AM TO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00040617</td>
<td>Negropedda Olycle</td>
<td>Other Sponsor</td>
<td>Contract</td>
<td>Submitted</td>
<td>GDG</td>
<td>Medical - IPA</td>
<td>170</td>
<td>17004053</td>
<td>BAYVIEW HOSPITAL</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>McGarvey</td>
<td>00085</td>
<td>NATI</td>
<td></td>
</tr>
<tr>
<td>00040609</td>
<td>Continuation</td>
<td>Organized Res</td>
<td>Subgrant</td>
<td>Submitted</td>
<td>Thrombosis Genetics, M</td>
<td>170</td>
<td>17004053</td>
<td>GERONIC</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>Walston</td>
<td>020093</td>
<td>UNIV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00040608</td>
<td>Re-Submission</td>
<td>Organized Res</td>
<td>Grant</td>
<td>Submitted</td>
<td>Molecular Mechanics</td>
<td>170</td>
<td>17004053</td>
<td>CLINICAL IMMUNOLOG</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>Kostantin</td>
<td>020086</td>
<td>NATI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00040606</td>
<td>Admin NB &amp; Clinical Research</td>
<td>Contract</td>
<td>Approved In PhA Multicenter</td>
<td>Submitted</td>
<td>INFECTIOUS DISEASE</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>Madarame</td>
<td>020074</td>
<td>WOOL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00040604</td>
<td>Organization</td>
<td>Organized Res</td>
<td>Subgrant</td>
<td>Submitted</td>
<td>ARCH</td>
<td>ERA Alcohol Res</td>
<td>170</td>
<td>170040112</td>
<td>GENERAL INTERNAL</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>O'Connor</td>
<td>020093</td>
<td>UNIV</td>
<td></td>
</tr>
<tr>
<td>00040672</td>
<td>Supplement</td>
<td>Organized Res</td>
<td>Subgrant</td>
<td>Submitted</td>
<td>The Wake Forest Center</td>
<td>170</td>
<td>17004051</td>
<td>CLINICAL IMMUNOLOG</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>Mathews</td>
<td>040106</td>
<td>WAKE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00040629</td>
<td>New</td>
<td>Organized Res</td>
<td>Grant</td>
<td>Submitted</td>
<td>Trojan Horse</td>
<td>170</td>
<td>170040119</td>
<td>GASTROENTEROLOGY</td>
<td>MEDICINE</td>
<td>SCHOOL OF</td>
<td>SCHOOL OF</td>
<td>Mette</td>
<td>020035</td>
<td>TECHN</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**510: Coeus Users in Unit Report**

**Description:** This report is intended for use by administrators. The report lists each Coeus user with an active account within a User-specified Unit. **Information provided:** each active Coeus user (ID, Name, user’s Unit, Home Unit, Email Address in Coeus) and their assigned Coeus Roles.

**Report Location:** Unit Hierarchy

**Definition of Terms:** Column Headings & Terms Defined

---

### Users by Selected Unit

<table>
<thead>
<tr>
<th>User ID</th>
<th>User Name</th>
<th>User’s Unit</th>
<th>Home Unit</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>AEWALD2</td>
<td>Ewald, Andrew</td>
<td>17015000</td>
<td>17015112</td>
<td><a href="mailto:aewald2@jhu.edu">aewald2@jhu.edu</a></td>
</tr>
<tr>
<td></td>
<td>Role Assignment</td>
<td>Proposal Creator, View Award Documents, View Awards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DANDREW2</td>
<td>Andrew, Deborah J</td>
<td>17015000</td>
<td>17015110</td>
<td><a href="mailto:dandrew2@jhu.edu">dandrew2@jhu.edu</a></td>
</tr>
<tr>
<td></td>
<td>Role Assignment</td>
<td>Proposal Creator, View Award Documents, View Awards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GWESTBR1</td>
<td>Westbrook, Demetria</td>
<td>17015000</td>
<td>17015000</td>
<td><a href="mailto:gwester1@jhu.edu">gwester1@jhu.edu</a></td>
</tr>
<tr>
<td></td>
<td>Role Assignment</td>
<td>Modify All Dev Proposals, Proposal Aggregator, Proposal Creator, Rolodex Maintainer, View Departments Proposals</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Person Reports (700 series)**

**700: Investigator History Report**

[return to List of Reports]

**Description:** This report contains all Awards and Institute Proposals, by award and proposal status, for a User-specified Investigator. Proposals not yet submitted to Sponsor are not included. Investigator data shown in this report pertains to ALL proposals and projects on which the Investigator is PI. **Information provided:** Award number, Institute Proposal number and link to Proposal Summary, Sponsor Name, Sponsor Award number (SAP Award ID), Award Type, Activity Type, Proposal Type, Start/End dates, Direct Cost and Total Cost. Investigator selected is a Co-investigator on proposals that do not contain dollar amounts (see Pending below).

**Report Location:** Person Search

**Definition of Terms:** Column Headings & Terms Defined

<table>
<thead>
<tr>
<th>Project Information</th>
<th>Project Total Budget Period Funding</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Grant #</strong></td>
</tr>
<tr>
<td>Active</td>
<td></td>
</tr>
<tr>
<td>Pi – Prince, Jerry L. Robotic Cerebral Segmentation for Neuromagnetic Analysis</td>
<td>106292</td>
</tr>
<tr>
<td>Pi – Prince, Jerry L. AN INTERACTIVE WEB-BASED GAME FOR COLLABORATIVE LABELING OF MEDICAL IMAGES</td>
<td>105892</td>
</tr>
<tr>
<td>Pi – Prince, Jerry L. ROBOT ASSISTED PROSTATE INTERVENTIONS IN BPH</td>
<td>105530</td>
</tr>
<tr>
<td>Pi – Prince, Jerry L. Prophylaxis of Speech Quality after Tongue Cancer Surgery</td>
<td>135588</td>
</tr>
<tr>
<td>Pi – Prince, Jerry L. AUTOMATIC CEREBELLAR BRIE LABELING IN HEALTH AND DISEASE</td>
<td>105852</td>
</tr>
<tr>
<td>Total: 5 Proposals</td>
<td></td>
</tr>
</tbody>
</table>

| Pending              |            |            |            |            |            |            |            |            |            |            |            |
| Pi – Prince, Jerry L. Trajet-based Analysis of White Matter Hypoconnectivity in Alzheimer’s Disease | 139695 | NIH | 139695 | Grant | Organized Research | 12/01/2011 | 11/30/2018 | $1,858,650.00 | $1,978,075.00 |
| Pi – Prince, Jerry L. Automatic Cerebellar MRI Labeling In Health and Disease | 140367 | NIH | 140367 | Grant | Organized Research | 07/01/2013 | 05/30/2016 | $1,729,838.45 | $2,876,429.79 |
| Total: 20 Proposals |            |            |            |            |            |            |            |            | $8,356,345.12 | $13,441,328.01 |

| Terminated           |            |            |            |            |            |            |            |            |            |            |            |
| Pi – Prince, Jerry L. Multiple-shell Diffusion Imaging of the Peripheral Nervous System | 102936 | NIH | 102936 | Grant | Organized Research | 08/10/2007 | 09/30/2011 | $40,820.00 | $51,872.00 |
| Pi – Prince, Jerry L. RSUI Site for Computer Integrated Surgical Systems and Technology | 160242 | NIH | 160242 | Grant | Instruction | 09/01/2007 | 08/31/2011 | $205,527.00 | $205,527.00 |
**702e: Other Support Tool**

**Description:** This tool is a worksheet - not a report - designed in cooperation with departmental administrators to assist them to complete the Investigator’s Other Support Report for Federal Sponsors. In this Tool the Investigator is referred to as the “Target Investigator”, or TI. The tool searches Coeus Institute Proposals and SAP GM Grant Master Data for any proposal on which the TI may have had Effort proposed and which proposal is Pending or is Funded on the User-specified ‘As of’ date.

The Tool consists of two Parts, each a unique search of databases in Coeus and GM Grant Master Data:

**“Part 1: TI is PI or Co-I on [active] SAP GM Grant Master Data awarded and [pending] Coeus Inst. Proposals.”**

Is a search of all grants in Coeus Award with a Status of Active, GM Grant Master Data with Status Approved Award, and all Coeus Institute Proposals records with a Status of Pending. It returns those records on which the Target Investigator is named as either the PI or a Co-I.

**“Part 2: TI is named on another PI’s [funded] Inst. Proposal and [active] GM Grant award.”**

Is a search of all Funded Institute Proposal Records on which the Target Investigator’s name appears as Co-I or Key Person. It excludes those records found in Part 1. This search is necessary because both GM Grant and Coeus Award have narrow definitions of ‘Co-I’. It returns those records in which the Target Investigator is a Co-I or Key Person on the proposal as submitted.

**Report Location:** Person Search

**Definition of Terms:** Column Headings & Terms Defined

**Information provided:**

<table>
<thead>
<tr>
<th>Target Investigator</th>
<th>Proposal Status</th>
<th>Project Start Date</th>
<th>Project End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigator for whom Other Support analysis is being performed. The person initially searched for in Coeus.</td>
<td>‘Funded’ – proposal is awarded and currently active in SAP. ‘Pending’ – proposal is pending and considered to be still under review by the sponsor (<em>). (</em>) Users should notify ORA if a Pending proposal will not be funded. ORA will update.</td>
<td>Status ‘Funded’ - Project start date as shown in GM Grant of the funded award. Status ‘Pending’ – Project start date proposed in the Proposal submitted to sponsor. The initial IP date is shown if multiple proposals were submitted.</td>
<td>Status ‘Funded’ - Project end date as shown in GM Grant of funded award. Status ‘Pending’ – Project end date proposed in the Proposal submitted to sponsor. The initial IP date is shown if multiple proposals were submitted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Period Start Date</th>
<th>Period End Date</th>
<th>Award Action</th>
<th>Direct Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status ‘Funded’ – Budget Begin Date on GM Grant Award Year Breakdown tab (AYB) of the current award period based on the User-specified ‘As Of’ date, Parameter 2, provided in the report. Status ‘Pending’ – Start date of the first year/period in the Institute Proposal (IP) record.</td>
<td>Status ‘Funded’ – Budget End Date on GM Grant Award Year Breakdown tab (AYB) of the current award period based on the User-specified ‘As Of’ date, Parameter 2, provided in the report. Status ‘Pending’ – Start date of the first year/period in the Institute Proposal (IP) record.</td>
<td>Status ‘Funded’ - GM Grant&gt;AYB Award Action Column for the AYB line(s)(*) encompassing the User-Specified ‘As Of’ date, Parameter 2, provided in the report. Status ‘Pending’ – Always ‘N/A’, not applicable to proposals records.</td>
<td>Status ‘Funded’ – GM Grant&gt;AYB Direct dollar amount for the AYB line(s)(*) encompassing the User-Specified ‘As Of’ date, Parameter 2, provided in the report. Status ‘Pending’ – Direct dollar amount of the first year/period in the Proposal budget.</td>
</tr>
<tr>
<td>IP (Proposed) Effort %</td>
<td>IP_&lt;br&gt;_PI /Person Name(*)</td>
<td>Award ID</td>
<td>Title</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------</td>
<td>----------</td>
<td>-------</td>
</tr>
<tr>
<td>This is always the Effort proposed in the Original Institute Proposal (IP) record for the Target Investigator.</td>
<td>Part 1 – ‘IP_PI’ is the PI on the displayed record, both SAP Award and Coeus IP. Part 2 – ‘Person Name’ is the Target Investigator.</td>
<td>If Status ‘Funded’ – Award ID assigned by sponsor if noted in GM Grant. If Status ‘Pending’ – Always ‘NA’, no data returned.</td>
<td>If Status ‘Funded’ – Title of GM Grant Award. If Status ‘Pending’ – Title of proposal as submitted and shown on initial IP.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Award PI</th>
<th>Sponsor Acronym</th>
<th>Sponsor</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Proposal Status is ‘Funded’, then Award PI is the PI on GM Grant. If Proposal Status ‘Pending’, no award has been made, so Award PI = NA.</td>
<td>Acronym assigned to sponsor by SSPS.</td>
<td>Sponsor name assigned to sponsor by SSPS.</td>
<td>If Status ‘Funded’ – Purpose is derived from GM Program (Primary IO)&gt;Additional Data Tab&gt;F&amp;A Function. If Status ‘Pending’ – Proposal Activity Type submitted to sponsor.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Proposal Type</th>
<th>Award Type</th>
<th>SAP Number</th>
<th>Proposal Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Status ‘Funded’ – from the IP Proposal Type. See below. If Status ‘Pending’ – from the original proposal submitted to sponsor.</td>
<td>If Status ‘Funded’ – from GM Grant&gt;General Data Tab&gt;Award Type. If Status ‘Pending’ – from Anticipated Award Type on the original proposal submitted to sponsor.</td>
<td>If Status ‘Funded’ – six-digit Award number assigned by Sponsored Projects Shared Services. If Status ‘Pending’ – NA.</td>
<td>If Status ‘Funded’ – from IP number of proposal as listed on the ‘Reference’ tab in GM Grant. If Status ‘Pending’ – IP number of proposal.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Grant Status</th>
<th>IMPORTANT NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part 1 - If Status ‘Active’ – means that award is active in Coeus Award &amp;/or Approved Award in SAP MG Grant. If record is a ‘Pending’ IP, then NA is displayed. Part 2 – If Status is ‘Active – means award has SAP Status of Approved Award.</td>
<td>This last cell in report is a text field for comments by Preparer and ORA Reviewer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Important Notice</th>
<th>Report Number</th>
<th>Parameter 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following data columns, known as Data Descriptors, are placed into each row of every ORIS Excel report in which the Report number ends in ‘e’. The Descriptors authenticate the row of data by telling users how to replicate that data. ORIS cannot validate any data from which these Descriptors have been removed.</td>
<td>ORIS Report number.</td>
<td>Person ID of the Target Investigator.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter 2</th>
<th>Run Time</th>
<th>Report Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-specified date “Other Support As of”. This is the date used to determine which records and AYB lines should be displayed in this report.</td>
<td>Date and Time at which report was generated.</td>
<td>ORIS Report title.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Host Name</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORIS name assigned to version of Coeus on which the report was generated. PROCOEUS is the main ‘production’ version at JHU.</td>
<td>This last cell in report is a text field for comments by Preparer and ORA Reviewer.</td>
</tr>
<tr>
<td>TARGET INVESTIGATOR</td>
<td>PROPOSAL STATUS</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Schutt</td>
<td>Funded</td>
</tr>
<tr>
<td>Schutt</td>
<td>Funded</td>
</tr>
<tr>
<td>ATL INST</td>
<td>Funded</td>
</tr>
<tr>
<td>ATL INST</td>
<td>Funded</td>
</tr>
<tr>
<td>ATL INST</td>
<td>Funded</td>
</tr>
</tbody>
</table>
710: Coeus Roles for User Report

**Description:** This report is intended for use by administrators. The report lists, for user-specified person, by Unit, each assigned Coeus role. **Information provided:** User Name, Unit Number, Unit Name, and Coeus roles assigned.

**Report Location:** [Person Search](#)

**Definition of Terms:** [Column Headings & Terms Defined](#)

---

Roles for Ahmanson, Elisa
- Roles in: (000001) JOHNS HOPKINS ENTERPRISE
  - JH BIRT REPORTS
- Roles in: (12073500) LABORATORY FOR COMPUTATIONAL SENSING AND ROBOTICS
  - Aggregator
  - Modify All Dev Proposals
  - Person Maintainer
  - Proposal Creator
  - Rolodex Maintainer
  - View Award
  - View Award Documents
  - View Institute Proposal
  - View Negotiations
  - View Subcontract
- Roles in: (12079800) ENGINEERING RESEARCH CENTER
  - Aggregator
  - Modify All Dev Proposals
  - Person Maintainer
Report Locations

Person Search

Select: Departmental>Personnel from Top Menu Bar or Select this Icon

Enter: Investigator information [use only one of the formats shown]

Highlight: name in Person list

Select: Report Title from Report>Menu
Unit Hierarchy Search

Overview of Search in the Unit Hierarchy

To run ORIS Reports using the Units Hierarchy the User must first open the Coeus Unit Hierarchy screen:

Select: Admin>Unit Hierarchy, from Top Menu Bar… or, Select this Icon

Choose: one of two Approaches to tell Coeus which Unit (or group of Units) to include in the ORIS Report:

- **Approach 1** - for those new to ORIS Reports
- **Approach 2** - for experienced ORIS Reports Users

*Note:* The Coeus Unit number, while corresponding to the SAP Cost Center number, is *eight digits* in length not ten. Coeus drops the two right-most digits in the SAP Cost Center number.

**Approach 1: Find Unit by ‘drilling down’ the Hierarchy**

First-time Users may find the ‘drilldown’ approach depicted below to be most useful. By Selecting successive “+” signs, one can display subordinate units to be reported in the ORIS Report.

Select: ‘+’ signs to display Unit detail
Highlight: Unit to be reported (ex. 17015110)

Select: Report Title from Report>Menu

Select: Report Parameters [example only]
Approach 2: Search by Unit Number

Experienced Users, those who know the Unit number in the Unit Hierarchy, may prefer this approach. By following a few simple steps, the User can go directly to the Unit and run the report. Shown below are three common reporting levels (levels of data aggregation) for School, Department, Sub-department or Center. Within Unit Hierarchy:

Select: Search Icon to open Unit Search screen

Enter: eight-digit Unit number, '*' asterisk is useful search tool

School: 17000000

Department: 17015000

Sub-department or Center: 17015110, or 1701511*

Highlight: Unit the Search ‘Result’
Coeus Highlights that Unit in the Unit Hierarchy:

Select: Report Title from **Report>Menu**

Select: Report Parameters - if required

Select: ‘Report Format’:

Select: ‘Print’:
1. **Activity Type** – is the primary function of the award. The Activity Types are Organized Research, Other Sponsored Activity, Instruction, and Clinical Research.

2. **Aggregated Division** – is an aggregation of the Divisions into the seven following categories: Bloomberg School of Public Health, Krieger School of Arts & Sciences, School of Education, School of Medicine, School of Nursing, Whiting School of Engineering, and the catch-all category All Others.

3. **Aggregated Sponsor Type** – is an aggregation of the Sponsor Types into the nine following categories: DHHS (Department of Health & Human Services), DOD (Department of Defense), Foreign, Foundation/Non-Profit, Institution of Higher Education, NSF (National Science Foundation), Other Federal, Private Profit, and State/Local Government.

4. **Announcement Number** – is the sponsor’s funding opportunity number.

5. **Anticipated Award Type** – see Award Type.

6. **Anticipated Total** – is the SAP GMGrant’s Funded Amount. The Anticipated Total is the amount of funding that the sponsor has promised the university over the entire life of the SAP Grant.

7. **ARRA Award** – is a SAP Grant with an Award Type of ARRA Contract, ARRA Grant, ARRA Subcontract, or ARRA Subgrant. Denotes that the funding was part of the American Recovery & Reinvestment Act.

8. **ARRA Proposal** – is an Institute Proposal containing an ARRA Science Code. Denotes that the proposal was submitted in response to an American Recovery & Reinvestment Act funding opportunity.

9. **Award Number** - is the SAP six-digit award number.

10. **Award ID** – this is the Award ID assigned by the sponsor if entered into SAP GM Grant Master Data.

11. **Award Action** – describes the specific reason for an increment of funding on a grant and is from GM Grant>Award Year Breakdown tab>Award Action field.

12. **Award Date** – is the Award Date listed in SAP GMGrant’s Award Year Breakdown tab. The Award Date is the fully executed date of the notice of award that provided funding.

13. **Award End** – is the SAP GMGrant’s Project End Date.

14. **Award Start** – is the SAP GMGrant’s Project Start Date.

15. **Award PI** – is the PI on the GM Grant Master data, if the Institute Proposal Status is ‘Funded’.

16. **Award Status** - see the Status definitions. The possible Award Statuses are Active, Pre Award, and Terminated.

17. **Award Type** – is the nature, category, of funding agreement underlying the award. The Award Types are Grant, Subgrant, Contract, Subcontract, Cooperative Agreement, Clinical Trial, and Fixed Fee. *See the specific definition for ORIS Report 702e Other Support Tool in that report’s detailed description.

18. **Business Area** – is the first three digits of the SAP Responsible Cost Center. The Business Area is unique to the School. For example, the Business Area for the School of Medicine is 170.

19. **CFDA Number** – is the Catalog of Federal Domestic Assistance number assigned by sponsor for funding opportunity.

20. **Current Budget Period** – when included in a column heading (ex. #104/105), this means that data displayed in the report is not total dollars, but rather first-period budget dollars of a pending Proposal and the
awarded dollars that correspond to the JHU Fiscal Year in which the report is generated and which are contained in SAP>GGM Grant>Award Year Breakdown screen.

21. **Deadline** – is the sponsor’s Deadline Date for the proposal as entered in the Proposal Development record. Deadline Dates are required for Grants.Gov proposals.

22. **Department** – is the Department based on the Unit Number. The Department is one level above the Unit.

23. **Direct & Direct Cost** – is the total direct costs. When referenced for Awards, this is the SAP GGM Grant Master Data total direct costs from the Award Year Breakdown Tab. When referenced for Institute Proposals, this is the total direct costs from the Institute Proposal.

24. **Division** – is the Division based on the Unit Number. The Division is one level above the Department; two levels above the Unit.

25. **Employee ID** – is the Person ID number from SAP HR. This is the unique, unchanging, numerical identifier for Johns Hopkins employees. The Person ID matches the employee’s first Personnel Number (PERNR) – an employee can have multiple Personnel Numbers which is why the Personnel Number is not used in ORIS Reports. In ORIS Reports, the Employee ID is the Person ID number for the person referenced in the report. For example, in ORIS Report 302e, the Employee ID column is beside the Principal Investigator column so the Employee ID listed is that of the Principal Investigator.

26. **End** – is the End Date. When referenced for Awards, this is from SAP GGM Grant Master Data. When referenced for Institute Proposals, this is the proposed/requested end date.

27. **Fiscal Month** – is the number of the JHU Fiscal Month. For example, ‘01’ is July. The Fiscal Month could be based on any date so be sure to reference the specific Report Catalog for details.

28. **Fiscal Year** – is the last two digits of the JHU Fiscal Year. For example, JHU’s Fiscal Year 13 runs from July 1, 2012 to June 30, 2013. The Fiscal Year could be based on any date so be sure to reference the specific Report Catalog for details.

29. **Grant Status** – [702e Other Support only] in the Part 1 Status ‘Active’ means that award is active in Coeus Award &/or is Approved Award in SAP MG Grant. If record status is ‘Pending’ it is an IP record and ‘NA’ is displayed. Part 2 – Status ‘Active’ means award has SAP Status of Approved Award.

30. **Home Unit** – is the SAP Cost Center assigned to the Coeus User’s OM (Payroll) position. Home Unit is imported into Coeus from SAP HR along with other person data. This field is editable within each proposal development record during its preparation. It can also be edited by users assigned the role of Person Maintainer.

31. **Indirect** – is total F&A costs. When referenced for Awards, this is the SAP GGM Grant Master Data total indirect costs from the Award Year Breakdown Tab. When referenced for Institute Proposals, this is the total indirect costs from the Institute Proposal.


33. **Inst. Proposal** – Institute Proposals are a copy the Proposal Development records upon submission to the sponsor. Institute Proposals track the sponsor’s funding decision. The IP number consists of 8 digits, where the first four contain the JHU Fiscal Year and Fiscal Month in which the proposal was first submitted by the PI for approval by ORA, e.g. 1001xxxx represents a submittal in FY 2010, July 2009. IP Statuses are: Pending, Funded, Not Funded, Withdrawn, and Void.

34. **IP (Proposed) Effort %** - Effort assigned to Target Investigator in the Coeus original Institute Proposal record.

35. **IP_PI / Person Name** – IP_PI in 702e Part 1 is the PI on the Coeus Inst. Proposal record. **Person Name** in Part 2 is the name of the Target Investigator.
36. **IPN Link** – when the Institute Proposal number is underscored in a report, the Institute Proposal is hyperlinked to the ORIS Proposal Summary Form. Opening the IPN link will provide the reader with useful information from the initial proposal submission: PI and Co-PIs, proposed effort, certain proposed budget information, as well as the various questions originally completed.

37. **ORA** – is the Office of Research Administration. There are five ORAs at JHU: Bloomberg School of Public Health ORA, Business and Research Administration (BARA) ORA servicing the Krieger School of Arts & Sciences, Research Projects Administration (RPA) servicing the Whiting School of Engineering and other university divisions, School of Medicine ORA, and the School of Nursing ORA.

38. **ORA Receipt Final Attempt** – is the date on which the ORA received the Proposal Development record on the final (or current) attempt of review and approval.

39. **ORA Receipt First Attempt** – is the date on which the ORA first received the Proposal Development record for review and approval.

40. **Period Start/End Dates** – *if Status is Funded* the dates are pulled from GM Grant Master Data>Award Year Breakdown>Budget Begin or Budget End Dates for specific row retrieved. *If Status is Pending* the dates are pulled from Institute Proposal record>Initial Budget Period Start and End dates.

41. **Principal Inv.** – is the Principal Investigator. When referenced for Awards, this is from SAP’s CMGrant Master data. When referenced for Institute Proposals, this is from the Institute Proposal record.

42. **Prime Sponsor Code** – is the Sponsor Code listed for the Prime Sponsor.

43. **Project Start/End Dates** – are the dates on which the entire Project (proposed project and awarded project) begin and end.

44. **Prop Development** – is the Proposal Development number.

45. **Prop Type** – See Proposal Type

46. **Proposal Number** – is the Inst. Proposal number.

47. **Proposal Type** – is the Proposal Type on the original submitted proposal. For Institute Proposal ORIS Reports, only Proposal Types New, Renewal, Supplement, Resubmission, and Task Order are included. For Proposal Development ORIS Reports, all Proposal Types are included.

48. **Proposal Status** – see the Status definitions. The possible Institute Proposal statuses are Funded, Not Funded, Pending, Withdrawn, and Void. There are also several Proposal Development statuses included in the status definitions.

49. **Prorated calculations** – the Financial Reports (Series 400) make extensive use of apportioning awards (grants) and requested funds (proposals) to User-specified data ranges. Calculation methods are defined in this Guide, Section “How are prorated amounts calculated...?”

50. **Purpose** – if Inst. Proposal Status is Funded the Purpose is derived from Award records Primary IO>GM Program>Additional Data Tab>F&A Function. If Inst. Proposal Status is Pending the Purpose is derived from the Proposal Activity Type submitted to sponsor.

51. **Rate of Funding** – is the percentage of the total requested funding that was awarded by the sponsor. Rate of Funding = Anticipated Total / Request Total Period Total for Institute Proposals that have a status of Funded. For example, if the proposal requested $100,000, but the sponsor only awarded $95,000, then the Rate of Funding for this project is 0.95 (or 95%). Another way to think about the Rate of Funding is by how much the sponsor cut the project’s budget. The Budget Cut is 1 minus the Rate of Funding. Budget Cut = 1 – Rate of Funding for Institute Proposals that have a status of Funded. For the example above, the Budget Cut for this project is 0.05 (or 5%).

52. **Request First Period Direct** – is the First Period’s requested direct amount from the Institute Proposal.

53. **Request First Period End** – is the First Period’s requested end date from the Institute Proposal.
54. **Request First Period Indirect** – is the First Period’s requested indirect amount from the Institute Proposal.

55. **Request First Period Start** – is the First Period’s requested start date from the Institute Proposal.

56. **Request First Period Total** – is the First Period’s requested total amount (direct + indirect) from the Institute Proposal.

57. **Request Total Period Direct** – is the proposal’s requested total direct amount from the Institute Proposal.

58. **Request Total Period End** – is the proposal’s requested end date from the Institute Proposal.

59. **Request Total Period Indirect** – is the proposal’s requested total indirect amount from the Institute Proposal.

60. **Request Total Period Start** – is the proposal’s requested start date from the Institute Proposal.

61. **Request Total Period Total** – is the proposal’s requested total amount (direct + indirect) from the Institute Proposal.

62. **Revenue Projection Reports** – prorate projected amounts within a User-specified date-range, usually a fiscal year. Projections are displayed for awarded projects and pending projects, where:

   a) **Awarded projects**: prorated amounts are calculated from active awards within a user specified date-range, using SAP GMGrant>Award Year Breakdown details. See the above definition of ‘Active’, because the Coeus definition is used, not SAP GMGRANT definition.

   b) **Pending projects**: prorated amounts are calculated from proposed total funding contained in the Coeus Institute Proposal total budgets where the IP has a Status of Pending. This approach approximates proposed research budgets.


64. **Routing Attempts** – is the number of times that the Proposal Development record had to be routed for department and/or ORA review and approval.

65. **Routing End** – is the date the Proposal Development record finished reviews and approvals. If this is blank, the Proposal Development record has not yet finished all reviews and approvals.

66. **Routing End User** – is the ORA Approver that completed the review and approval of the Proposal Development record. If this is blank, the Proposal Development record has not yet finished all reviews and approvals.

67. **Routing Next Approver** – is the Primary Approver of the stop at which the Proposal Development record is currently being reviewed and waiting for approval. If this is blank, the Proposal Development record has finished all reviews and approvals.

68. **Routing Start** – is the date the Proposal Development record begins reviews and approvals.

69. **Routing Start User** – is the aggregator of the Proposal Development record that initiates reviews and approvals.

70. **S2S Status, Agency Tracking Number Assigned** – is the system-to-system Status for proposals that were submitted error-free to Grants.Gov.

71. **S2S Status, Grants.Gov Submission Error** – is the system-to-system Status for proposals that were found with errors at time of submission.

72. **S2S Status, Received by Agency** – is the system-to-system Status for proposals that did not pass sponsor validations.

73. **S2S Status, Rejected with Errors** – is the system-to-system Status for proposals that did not pass Grants.Gov validations.
74. **S2S Type** – is the system-to-system Application Type as shown in the Grants.Gov window of the Proposal Development record. The system-to-system Application Types are Application, Pre-Application, and Change/Corrected Application.

75. **SAP Number** – is the six-digit grant number assigned by Sponsored Projects Shared Services.

76. **Sponsor** – is the sponsor for the project. When referenced for Awards, this is the sponsor as contained in SAP GMGrant Master Data. When referenced for Institute Proposals, this is the sponsor as referenced on the record in Coeus.

77. **Sponsor Acronym** – is the acronym assigned to the sponsor by Sponsored Projects Shared Services.

78. **Sponsor Award #** – is the Award ID from SAP GMGrant Master Data.

79. **Sponsor Code** – is the Sponsor’s six digit code.

80. **Sponsor Type** – is the category of the Sponsor.

81. **Start** – is the Start Date. When referenced for Awards, this is from SAP GMGrant Master Data. When referenced for Institute Proposals, this is the proposed/requested start date.

82. **Status, Active** – is the Coeus Award Status when the SAP Grant User Status is “Approved Awarded” and the SAP Project End Date is on, or after, today’s date. See Caveat 2.

83. **Status, Approved** – is the Proposal Development Status for proposals that have been approved by the ORA, but not yet submitted to the sponsor.

84. **Status, Approval in Progress** – is the Proposal Development Status when the proposal is undergoing review and approval by the department and/or ORA.

85. **Status, Funded** – is the Institute Proposal Status when the award is created in SAP GM Grant.

86. **Status, Pending** – is the Institute Proposal Status when the sponsor has yet to render a funding decision. Coeus automatically changes the Status from Pending to Not Funded 365 days after the proposed/requested start date.

87. **Status, Post-Submission Approval** – is the Proposal Development Status for proposals that have been submitted to the sponsor, but are still undergoing review and approval by the department and/or ORA.

88. **Status, Post-Submission Rejection** – is the Proposal Development Status for proposals that have been submitted to the sponsor before review and approval by the department and/or ORA. During the post-submission review and approval, the proposal was found to be incomplete or inaccurate.

89. **Status, Submitted** – is the Proposal Development Status for proposals that have been approved and submitted to the sponsor.

90. **Status, Terminated** – is the Coeus Award Status when the Award is from ReSource (ended prior to SAP startup on 1/1/07) and therefore was not assigned an SAP Grant number, the SAP Grant has a User Status of “Temporarily Closed”, or the SAP Grant has a User Status of “Approved Awarded” and the SAP Project End Date is before today’s date (See Caveat 2).

91. **Status, Not Funded** – is the Institute Proposal Status when the sponsor notified JHU that the proposal would not be awarded.

92. **Status, Withdrawn** – is the Institute Proposal Status when the Investigator decided to remove the proposal from sponsor consideration after the proposal was approved for submission by ORA.

93. **Status, Void** – is the Institute Proposal Status of a proposal never submitted to sponsor and removed from further consideration.

94. **Subcontract Flag** – is the checkbox in the Coeus proposal record that indicates whether or not the proposal contains a subcontract. A check (“Yes”) indicates a subcontract and a blank box (“No”) indicates the absence of a subcontract.
95. **Submission Date** – is the creation date of the Institute Proposal. Since the Institute Proposal is created when the ORA selects the “Approve” or “Submit to Sponsor” buttons, the Submission Date should be the date that the proposal is submitted to the sponsor.

96. **Success Rate** – number of Institute Proposals with a Status of Funded divided by the sum of Institute Proposals with a Status of Pending, Funded, and Not Funded. Success Rate = # of Funded Institute Proposals / (# of Pending + # of Funded + # of Not Funded Institute Proposals)

97. **Target Investigator** – [702e only] the Investigator for whom Other Support analysis is being performed and the person initially searched for to generate the 702e report.

98. **Title** – is the project title. When referenced for Awards, this is from SAP GMGrant Master Data. When referenced for Institute Proposals, this is the title from the Institute Proposal in Coeus.

99. **Total** – total costs. When referenced for Awards, this is the amount shown in the SAP GMGrant Master Data, Funded Amount field. When referenced for Institute Proposals, this is the total amount proposed/requested.

100. **Tot. Direct & Tot. Indirect Cost** – when an award falls within a user-specified date-range, the entire Direct Cost and Indirect Cost is shown. These amounts are not prorated or otherwise apportioned. This applies to Report 202.

101. **Unit Name** – is the assigned name for the Coeus unit number.

102. **Unit Number** – is the Coeus unit number assigned for a School, department, or center. Generally, Coeus unit numbers closely correspond to the SAP Cost Center numbers.

103. **User’s Unit** – is the Coeus Unit number in which User’s first Coeus role was assigned, or the Unit number subsequently edited by ORIS. This field can only be edited by ORIS.

104. **Weekdays Routed Before DL** – is the number of weekdays that the Proposal Development record first began reviews and approvals before the Deadline Date, not including the Deadline Date.

105. **Weekdays ORA Received Before DL** – is the number of weekdays that the ORA first received the Proposal Development before the Deadline Date, not including the Deadline Date.